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Weekly Forecast &  

Detailed Lesson Plan 

FIRST TERM COMPUTING LESSON NOTES – BASIC 7 

SCHEME OF LEARNING – TERM 1 

WEEKS STRAND SUB STRANDS INDICATORS RESOURCES 

1  
Introduction to 

computing   

Components of 

Computer 
B7.1.1.1.1-2  

Set of computer, 

Video /pictures, wall 

chart  

2  
Introduction to 

computing   

Components of 

Computer 
B7.1.1.1.3-4  

Wireless keyboard, 

and mouse, light 

pen  

3  
Introduction to 

computing   
Computer Systems  B7.1.1.2.1-2  

Hard drives, CD, 

DVD, floppy disk, 

etc.  

4  
Introduction to 

computing   

Technology in the 

community  
B7.1.2.1.1-2.  

Set of computer, 

Video /pictures, wall 

chart  

5  
Introduction to 

computing   

Technology in the 

community  
B7.1.2.1.3-4.  

Set of computer, 

Video /pictures, wall 

chart  

6  
Introduction to 

computing   

Technology in the 

community  
B7.1.2.1.5-6.  

Set of computer, 

Video /pictures, wall 

chart  

7  
Introduction to 

computing   

Health and Safety in using 

ICT tools  
B7.1.3.1.1-2  

Set of computer, 

Video /pictures, wall 

chart  

8  
Introduction to 

computing   

Health and Safety in using 

ICT tools  
B7.1.3.1.3-4  

Pictures and videos 

of ICT tools  
9  

Productivity  

Software   

Introduction to Word 

Processing  
B7.2.2.1.1-3.  

10  
Productivity  

Software   

Introduction to 

Presentation  
B7.2.2.2.3. 

Set of computer, 

Video /pictures, wall 

chart  

11 REVISION 

12 END OF TERM ASSESSMENT AND VACATION 
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Detailed Lesson Plan 

WEEK 1 

Date:  Period:  Subject: Computing 

Duration: 50 mins. Strand: Introduction To Computing 

Class: B7 Class Size:  Sub Strand: Components of Computer 

Content Standard:  

B7.1.1.1. Examine the parts of a 

computer 

Indicator:  

B7.1.1.1.1Discuss the fourth-generation computers 

Lesson: 

 

1 of 6 

Performance Indicator:  

Learners can discuss features of fourth generation computers 

Core Competencies: 

CI, CC, CL, CI 6.1, CC 7.4 

 

References : Computing Curriculum Pg. 3 

Keywords : microchip, generation, circuit 

 

Phase/Duration Learners Activities Resources 

PHASE 1: STARTER Use questions and answers, find out what learners already 

know about the fourth generation computers. 

 

Share with learners the performance indicators. 

Set of computer, 

Video /pictures, wall 

chart 

PHASE 2: NEW 

LEARNING 

Let learners discuss features of fourth generation 

computers  
The computers of fourth generation used very large scale integrated 

(VLSI) circuits. This made computers more powerful, compact, reliable 

and affordable. As a result, it gave rise to personal computers (PC) 

revolution. E.g. desktop computers, laptop, notebook, etc. 

 

Guide learners to Identify a microchip  

 
 

Engage learners to explore the architecture of a 

processor. 

 

Assessment 

1. State any two features of fourth generation computers 

2. What is the main function of the microchip in 

computers 

3. Processors are also known as 
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Detailed Lesson Plan 

PHASE 3: 

REFLECTOIN 

Use peer discussion and effective questioning to find out 

from learners what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

 

Ask learners how the lesson will benefit them in their 

daily lives. 
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Detailed Lesson Plan 

 

Date:  Period:  Subject: Computing 

Duration: 50 mins. Strand: Introduction To Computing 

Class: B7 Class Size:  Sub Strand: Components of Computer 

Content Standard:  

B7.1.1.1. Examine the parts of a 

computer 

 

Indicator:  

B7.1.1.1.2 Demonstrate understanding in the use of 

input devices 

Lesson: 

 

2 of 6 

Performance Indicator:  

Learners can identify input devices and state its uses 

Core Competencies: 

CI 6.1, CC 7.4 

 

References : Computing Curriculum Pg. 3 

Keywords : wireless, touchscreen, barcode 

 

Phase/Duration Learners Activities Resources 

PHASE 1: STARTER Use questions and answers, find out what learners already 

know about input devices. 

 

Share with learners the performance indicators. 

Set of computer, 

Video /pictures, wall 

chart 

PHASE 2: NEW 

LEARNING 

Engage learners to watch video or picture of input 

devices e.g. wireless keyboard, mouse and touchscreen in 

class  

  

Demonstrate to learners the use of input devices in a 

computer laboratory/classroom.  

  

Have learners to distinguish manual (e.g. keyboard, etc.) 

and automatic (e.g. barcode reader etc.) input devices.  

  

Let learners explore the advantages and disadvantages of 

input devices  

  

Learners to explore areas where different types of input 

devices are used. 

 

Assessment 

1. what is an input device? 

2. mention the least input devices of a computer 

3. draw any 2 input device. 

 

PHASE 3: 

REFLECTION 

Use peer discussion and effective questioning to find out 

from learners what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

 

Ask learners how the lesson will benefit them in their 

daily lives. 
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Detailed Lesson Plan 

WEEK 2 

Date:  Period:  Subject: Computing 

Duration: 50 mins. Strand: Introduction To Computing 

Class: B7 Class Size:  Sub Strand: Components of Computer 

Content Standard:  

B7.1.1.1. Examine the parts of a computer 

 

Indicator:  

B7.1.1.1.3. Examine the uses of the output 

devices: 

Lesson: 

 

2 of 6 

Performance Indicator:  

Learners can identify input devices and state its uses 

Core Competencies: 

CI 6.1, CC 7.4 

References : Computing Curriculum Pg. 3 

Keywords : wireless, touchscreen, barcode 

 

Phase/Duration Learners Activities Resources 

PHASE 1: STARTER Use questions and answers, find out what learners already 

know about input devices. 

 

Share with learners the performance indicators. 

 

PHASE 2: NEW 

LEARNING 

Engage learners to watch video or pictures of output 

devices in use.  

 
 

Using the pictures, brainstorm learners to come out with 

the use of the output devices. 

 

Guide learners to demonstrate the use of output devices 

in a computer laboratory or classroom.  

 

Let learners explore the advantages and disadvantages of 

output devices. 

 

ASSESSMENT 

• What is an output device? 

• Mention any five output device you know. 

• State the functions of the output devices stated above 

Set of computer, 

Video /pictures, wall 

chart 



 
OVEC Press 
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Detailed Lesson Plan 

PHASE 3: 

REFLECTION 

Use peer discussion and effective questioning to find out 

from learners what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

 

Ask learners how the lesson will benefit them in their 

daily lives. 
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Weekly Forecast &  

Detailed Lesson Plan 

 

Strand : Introduction to computing   Class : B7 

Sub Strand: Components of Computer Duration : 

Content Standard: B7.1.1.1. Examine the parts of a computer Date :  

Indicators: B7.1.1.1.4 Examine full-sized external hard drives, hard drive speed, disk 

caching, Storage portable hard drives, Optical Discs and Drives 

Day : 

Key words: magnetic storage devices, portable hard drives, Optical Discs and Drives 

Resources: Set of computer, Video /pictures, wall chart 

 

Activities For Learning & Assessment Progression  

Starter (5 mins) 

 

Recap with learners to find out what they already know about storage devices. 

 

Share with learners the performance indicators. 

 

 

Main (35 mins) 

Guide learners to Identify magnetic storage devices, portable hard drives/Optical Discs 

and Drives or pictures of these items to class.  

 

Learners to discuss the features of hard drives/Optical Disc storage media.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Let learners explore the maximum capacities of these storage devices.  

1. a floppy disk is able to store 360KB and 1.44MB of data 

2. a compact disc (CD) is able to store 700MB to 750MB of data. 

 

Explore the different write speeds of these storage devices.  

1. SD cards will read and write at speeds of 12.5MB/s 

2. a typical 7200 RPM HDD will deliver a read/write speed of 80-160MB/s 

3. the write speed of 2.0 USB can be as slow as 4MB per second and as fast as 8MB/s. 

 

Explore the differences in the various Hard Disk Drives (HDD).  

 

 

 

Learning how to 

identify and use 

storage devices 
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Detailed Lesson Plan 

Reflection (10 mins) 

Use peer discussion and effective questioning to find out from learners what they have 

learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

 

Ask learners how the lesson will benefit them in their daily lives. 

Homework/Project Work/Community Engagement Suggestions 

• What is a storage device? 

• Identify the primary storage devices of a computer. 

• Identify any four secondary storage devices of the computer 

Cross-Curriculum Links/Cross-Cutting Issues 

 

Potential Misconceptions/Student Learning Difficulties 

The facilitator can arrange to use the nearby school’s computer lab 
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Detailed Lesson Plan 

WEEK 3 

Strand : Introduction to computing   Class : B7 

Sub Strand: Computer Systems Duration : 

Content Standard: B7.1.1.2. Demonstrate the use of the features of the 

Windows Desktop 

Date :  

Indicators: B7.1.1.2.1 Discover the latest Windows Operating System 

(Start screen, Use of tiles, Taskbar buttons, Preview thumbnails), temporal 

peeking into a window on a taskbar 

Day : 

Resources: Set of computer, Video /pictures, wall chart 

 

Activities For Learning & Assessment Progression  

Starter (5 mins) 

Recap with learners to find out what they already know about the 

computers’ desktop. 

 

Call up volunteers to mention some features of the computers’ desktop 

 

Share the performance indicators with learners. 

 

 

Main (35 mins) 

Brainstorm learners to describe the computers desktop. 

 

Turn on a computer and ask learners to observe the computers 

desktop. 

 

Ask learners to identify some of the things they see on the screen. 

 

Learners to identify things they have not seen before on a computers 

screen. 

 

 

Guide learners to identify the features of the desktop. 

• Taskbar 

• Start button 

• Icons 

• Wallpaper 

• Mouse pointer 

 

 

Exploring the features of the 

desktop 
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Detailed Lesson Plan 

 
 

 

Assist learners to navigate through the features on the desktop. 

 

Guide learners to demonstrate how to preview thumbnails. 
A thumbnail is a compressed preview image of the original that is used as a 

placeholder. 

 

Let learners explore the features of the taskbar.  

 

Demonstrate how to preview windows on the taskbar. 

 

 

Reflection (10 mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

 

In groups, let learners navigate through the features of the desktop. 

Homework/Project Work/Community Engagement Suggestions 

• What is a computers’ desktop 

• Identify the features of the computer’s desktop 

• Explain the following 

a) Icons    b) wallpaper   c) taskbar 

Cross-Curriculum Links/Cross-Cutting Issues 

 

Potential Misconceptions/Student Learning Difficulties 

The facilitator can arrange to use the nearby school’s computer lab 
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Detailed Lesson Plan 

 

Strand : Introduction to computing   Class : B7 

Sub Strand: Computer Systems Duration : 

Content Standard: B7.1.1.2. Demonstrate the use of the features of the Windows 

Desktop 

Date : 

Indicators: B7.1.1.2.2 Practice file management techniques Day : 

Key words: files, folder, extension 

Resources: Set of computer, Video /pictures, wall chart 

 

Activities For Learning & Assessment Progression  

Starter (5 mins) 

Using questions and answers, find out what learners already know about file and 

folders. 
 

Share with learners the performance indicators. 

 

 

 

Main (35 mins) 

Guide learners to explore different account levels for users of computer systems.  

A user account is a location on a network server used to store a computer username, 

password, and other information. 

The account users may be a regular user or guest user. 

 

Have learners to explore different permission levels that are applied to files and 

folders. 

Files and folder permissions control what user is permitted to perform which actions on a 

file or folder. 

Files and directories can have three types of permissions: read, write and execute. 

 

Lead learners to demonstrate file management techniques by following the naming 

conventions and organizing files in folders and subfolders. 

File management includes; 

• Renaming - (giving a desired name to a file of folder) 

• Moving – (copy and paste, cut and paste methods) 

• Deleting – (moving unused files and folder into the Recycle Bin) 

 

Explore the types and importance of file extensions. 

A file extension is a string of characters attached to a filename, usually preceded by a full 

stop and indicating the format of the file. 

Examples are DOC and DOCX, HTML and HTM, ODT, PDF, XLS and XLSX, 

ODS, PPT, TXT, MP3, etc.  

 

 

Reflection (10 mins) 

Use peer discussion and effective questioning to find out from learners what they 

have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

 

In groups, learners create folders and files. 

Practicing file 

management 

techniques 
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Detailed Lesson Plan 

Homework/Project Work/Community Engagement Suggestions 

• What is a file? 

• What is a folder? 

• State the steps in creating a folder. 

• Mention any three file extensions you know. 

Cross-Curriculum Links/Cross-Cutting Issues 

 

Potential Misconceptions/Student Learning Difficulties 

The facilitator can arrange to use the nearby school’s computer lab 

 

 

 

  



 
OVEC Press 
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Detailed Lesson Plan 

WEEK 4 

Strand : Introduction to computing  Class : 

Sub Strand: Technology in the community Duration : 

Content Standard: B7.1.2.1. Demonstrate the use of 

Technology in the community 

Date :  

Indicators: B7.1.2.1.1. Describe and give examples of at least five 

technology tools for learning in each subject 

Day : 

Key words: YouTube, Encarta, Microsoft office, calculators 

 

Activities For Learning & Assessment Equipment/Resources Progression  

Starter (5 mins) 

Have learners watch a video on current issues in Ghana. 

Example: Discussion on E-levy 

 

Assessment? 

1. what helped us to watch the video? 

2. what part of the video did you like best? 

 

Share the performance indicators and introduce the lesson. 

 

 

 

Main (35 mins) 

Brainstorm the meaning of technology tools. 

Technology tools refers to software or gadgets that can be used to 

develop or support learning or service. 

Example: YouTube, Encarta, Microsoft office, calculators, radio, 

television, etc. 

  

Explore various technology tools that can be used for learning 

(Educational Software) by guiding learners to surf the internet to 

discover more about such tools.  

Example:  

In Mathematics:  

- Spreadsheet and calculator for calculations 

- Television for watching Brilliant Science and Math quiz, PSI on 

Math. 

 

In English  

Word Processor – vocabulary, spelling, synonyms and antonyms  

Radio for listening to Everyday English 

 

In Science:  

- Television for watching Brilliant Science and Math quiz  

 

Other Subjects  

Encarta Program – for searching for information on various topics  

Internet – is used to search for information on various topics. 

 

Guide learners to brainstorm some technology tools for learning 

Internet connection, 

laptop/mobile phone, 

applications (Scratch), 

light bot, spreadsheet 

(MS Excel or Open office 

Calc), presentation (MS 

PowerPoint or Open 

office Impress), Virtual 

Museum (second canvas). 

Understanding 

what technology 

tools are, and 

their uses. 

 

 

Identifying and 

exploring some 

technology tools 

e.g. light bot, 

scratch 
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Weekly Forecast &  

Detailed Lesson Plan 

 

 

 

Reflection (10 mins) 

Use peer discussion and effective questioning to find out from 

learners what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

 

Ask learners how the lesson will benefit them in their daily lives. 

Homework/Project Work/Community Engagement Suggestions 

Task learners to surf the internet or newspaper articles to identify other technology tools not mentioned. 

Cross-Curriculum Links/Cross-Cutting Issues 

 

Potential Misconceptions/Student Learning Difficulties 

• Learners may have a problem browsing the internet in areas with weak network reception.  

• Learners experiencing challenges with various websites may need assistance when browsing the internet and 

using the technology tools 
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Strand : Introduction to computing   Class : 

Sub Strand: Technology in the community Duration : 

Content Standard: B7.1.2.1. Demonstrate the use of 

Technology in the community 

Date :  

Indicators: Demonstrate the use of at least three technology 

tools identified in B7.1.2.1.1 

Day : 

Key words: 

 

Activities For Learning & Assessment Equipment/Resourc

es 

Progression  

Starter (5 mins) 

Recap with learners to review their understanding in the previous 

lesson. 

 

Share performance indicator with learners. 

 

 

 

Main (35 mins) 

In turns, learners mention at least three examples of technology tools. 

 

Show pictures or video as to how the tools are used. 

 
 

Learners discuss the uses of the technology tools and relate to them. 

Engage learners to demonstrate the use of a technology tool in groups 

and present to the whole class how that tool works. 

 

 

 

Reflection (10 mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

 

Ask learners how the lesson will benefit them in their daily lives. 

Manila card, flipchart Identifying any three 

(3) technology tools 

that aid learning. 

 

 

Understanding the 

uses of the 

technology tools 

mentioned 
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Detailed Lesson Plan 

Homework/Project Work/Community Engagement Suggestions 

Learners should look for additional technology tools and their uses 

Cross-Curriculum Links/Cross-Cutting Issues 

None 

Potential Misconceptions/Student Learning Difficulties 

• Learners may have a problem browsing the internet in areas with weak network reception.  

• Learners experiencing challenges with various websites may need assistance when browsing the internet and using 

the technology tools 

 

 

  



 
OVEC Press 

Weekly Forecast &  

Detailed Lesson Plan 

WEEK 5 

Strand : Introduction to computing   Class : B7 

Sub Strand: Technology in the community Duration : 

Content Standard: B7.1.2.1. Demonstrate the use of 

Technology in the community 

Date :  

Indicators: B7.1.2.1.3. Discuss the benefits of using technology 

tools in learning 

Day : 

Key words: 

 

Activities For Learning & Assessment Equipment/Resourc

es 

Progression  

Starter (5 mins) 

 

Using questions and answers, review learners understanding in the 

previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

 

 

Main (35 mins) 

 

Revise with learners on what technology tools are. 

 

Guide learners to discuss in pairs the benefits of using technology tools 

in learning (e.g. using spreadsheet to draw graphs) 

Example:  
1. It makes teaching easy and interesting.  

2.I CT facilitates sharing of resources, expertise and advice.  

3.There is greater flexibility in carrying out their work as teachers.  

4.They gain ICT literacy skills, confidence and are enthusiastic about their work.  

5.Easier planning and preparation of lessons and designing materials  

6.Students easily learn at their own pace.  

7.Students who use ICT in school are more motivated to learn.  

8.It encourages the student to be independent and active in his/her learning and be 

self-responsible.  

9.Teaching is more focused and tailored to students’ strengths and weaknesses..  

10.Gains in understanding and analytical skills, including improvements in reading 

comprehension. 

 

Let learners discuss the negative effects, if any of technology tools in 

learning. 

 

Guide learners to identify the limitations of technology tools in teaching 

and learning. 

 

 

Reflection (10 mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

Manila card, flipchart, 

surfing the internet for 

solutions 

Identifying any 

three (3) benefits 

of technology 

tools that aid 

learning. 

 

Describing the 

benefits of 

technology tools 

that aid learning 
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Detailed Lesson Plan 

 

Take feedback from learners and summarize the lesson.  

 

Ask learners how the lesson will benefit them in their daily lives. 

Homework/Project Work/Community Engagement Suggestions 

What are technology tools 

State three benefits of technology tools in learning 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

• Learners may have a problem browsing the internet in areas with weak network reception.  

• Learners experiencing challenges with various websites may need assistance when browsing the internet and using 

the technology tools.  

• Learners may not appreciate that the internet is also a technology tool. 

 

  



 
OVEC Press 

Weekly Forecast &  

Detailed Lesson Plan 

Strand : Introduction to computing   Class : B7 

Sub Strand: Technology in the community Duration : 

Content Standard: B7.1.2.1. Demonstrate the use of Technology in the 

community 

Date :  

Indicators: B7.1.2.1.4. Examine the negative impact of computers and 

computer use on the environment 

Day : 

Key words: 

 

Activities For Learning & Assessment Equipment/Resources Progression  

Starter (5 mins) 

Recap with learners to find out what they already know about green 

computing. 

 

Share performance indicators and introduce the lesson. 

 

 

 

Main (35 mins) 

 

Brainstorm learners to explain what green computing is. 
Green computing is the sustainable approach in the design, manufacture, use, 

and disposal of IT resources. 

 

Let learners observe people who use and work with computers in 

the community.  

  

Learners to visit websites or watch videos/pictures of how 

computers, including other electronic components, are disposed of.  

  

 

 

 

 

 

Let learners discuss the impact of computers and computer use on 

the environment.  

Example: computers heavy metals, such as lead and toxic chemicals that pollute 

the soil and contaminate groundwater. 

 

Engage learners to discuss the benefits of practicing green 

computing. 

Example: it reduces the energy consumption which results into low carbon 

dioxide emission. 

It saves that will be spent in extra usage of energy and resources. 

 

 

Reflection (10 mins) 

Use peer discussion and effective questioning to find out from 

learners what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

 

Manila card, flipchart, 

surfing the internet for 

solutions 

Identifying any 

three (3) benefits of 

technology tools 

that aid learning. 

 

Describing the 

benefits of 

technology tools 

that aid learning 
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Detailed Lesson Plan 

Ask learners how the lesson will benefit them in their daily lives. 

Homework/Project Work/Community Engagement Suggestions 

• What is green computing? 

• Identify three effects of computer usage on the environment 

• Write three benefits of green computing. 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

• Learners may have a problem browsing the internet in areas with weak network reception.  

• Learners experiencing challenges with various websites may need assistance when browsing the internet and using 

the technology tools.  

• Learners may not appreciate that the internet is also a technology tool. 

 

 

  



 
OVEC Press 

Weekly Forecast &  

Detailed Lesson Plan 

WEEK 6 

Strand : Introduction to computing   Class : B7 

Sub Strand: Technology in the community Duration : 50 mins 

Content Standard: B7.1.2.1. Demonstrate the use of Technology in the 

community. 

Date :  

Indicators: B7.1.2.1.5. Propose environmentally responsible practices that can 

be used to reduce the negative impact of computers and computer use on the 

environment 

Day : 

Key words:6 

 

Activities For Learning & Assessment Equipment/Reso

urces 

Progression  

Starter (5 mins) 

 

Recap with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

 

Main (35 mins) 

Bring pictures of energy-efficient gadgets or devices to class e.g. energy 

saving light bulbs, energy-efficient cooking stoves, toilet water saver, solar 

chargers, energy saving shower heads etc. to class.  

 

Guide learners to discuss in groups and present to the whole class 

examples of energy-efficient devices and techniques. 

 

Revise with learners on the negative impact of computers and computer 

use on the environment. 

Example: Negative effects – resource depletion ,pollution, privacy and 

security etc 

 

Guide learners to discuss how the negative effects identified can be 

reduced.  

Example: avoid wasting electricity, avoid wasting paper, dispose of old 

equipment responsibly 

  

Guide learners to evaluate environmentally responsible practices.  

  

Put learners in groups to propose measures to effectively manage e-waste 

in a particular environment (e.g. Agbogbloshie). 

Manila card, 

flipchart, surfing 

the internet for 

solutions 

Proposing 

environmentally 

responsible 

practices that can 

be used to reduce 

the negative impact 

of computers and 

computer use on 

the environment 
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Detailed Lesson Plan 

 
 

Reflection (10 mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

Homework/Project Work/Community Engagement Suggestions 

• Identify any two negative effect of computers on the environment. 

• State two ways of reducing the negative effects identified.  

Cross-Curriculum Links/Cross-Cutting Issues 

 

Potential Misconceptions/Student Learning Difficulties 

• Learners may have a problem browsing the internet in areas with weak network reception.  

• Learners experiencing challenges with various websites may need assistance when browsing the internet and 

using the technology tools.  

• Learners may not appreciate that the internet is also a technology tool. 

 

  



 
OVEC Press 

Weekly Forecast &  

Detailed Lesson Plan 

 

Strand : Introduction to computing   Class : B7 

Sub Strand: Technology in the community Duration : 50 mins 

Content Standard: B7.1.2.1. Demonstrate the use of 

Technology in the community. 

Date : 

Indicators: B7.1.2.1.6. Create a component from disposed 

computer parts. 

Day : 

Key words:6 

 

Activities For Learning & Assessment Equipment/Resourc

es 

Progression  

Starter (5 mins) 

 

Recap with learners to find out what they already know about 

computer recycling. 

 

Share performance indicators and introduce the lesson. 

 

 

 

Main (35 mins) 

 

Guide learners to explain the meaning of computer recycling. 

Computer recycling is the disassembly and separation of components and 

raw materials of waste electronics. 

 

Learners to discuss the importance of computer recycling. 

 

Task learners to collect and bring disposed computer/electronic parts 

from the community to school.  

 

Lead learners to create a component from the disposed computer 

parts. 

 

Have learners watch a video/picture depicting the recycling of 

computer parts. 

 

 

 

Reflection (10 mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

 

Ask learners how the lesson will benefit them in their daily lives. 

Manila card, flipchart, 

surfing the internet for 

solutions 

Demonstrating the 

use of Technology in 

the community. 

 

 

Creating a 

component from 

disposed computer 

parts. 

Homework/Project Work/Community Engagement Suggestions 

Learners to create a component from disposed computer parts. 

Cross-Curriculum Links/Cross-Cutting Issues 
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Detailed Lesson Plan 

Potential Misconceptions/Student Learning Difficulties 

• Learners may have a problem browsing the internet in areas with weak network reception.  

• Learners experiencing challenges with various websites may need assistance when browsing the internet and using 

the technology tools.  

• Learners may not appreciate that the internet is also a technology tool. 
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WEEK 7 

Strand : Introduction to computing   Class : B7 

Sub Strand: Health and Safety in using ICT tools Duration : 50mins 

Content Standard: B7.1.3.1. Demonstrate how to apply Health 

and Safety measures in using ICT Tools 

Date : 

Indicators: B7.1.3.1.1 Describe health measures and current 

regulatory requirements and potential computing-related disorders 

Day :  

Key words: typing, injuries, posture 

 

Activities For Learning & Assessment Equipment/Resou

rces 

Progression  

 Starter (5 mins) 

 

Recap with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

 

Main (35 mins) 

 

Let learners mention some examples of ICT tools used at home. 

 

Engage learners to discuss the uses of the ICT tools identified. 

 

Put learners in groups to brainstorm and discuss the possible health 

hazards associated with long term exposure to the use of ICT tools. 

 

Engage learners to watch videos on the health hazards of prolonged use 

of computing devices or show pictures of bad body postures and other 

hazards in using computing devices.  

e.g. hearing impairment from loud Public Address (PA) Systems, vision 

impairment from the monitor, repetitive strain injury, Carpal tunnel syndrome, 

computer vision syndrome, etc.  

 

Guide learners to discuss the risk involved in receiving a call while the 

mobile phone is on charge.  

 

Guide learners to identify the health hazards associated with each ICT 

device. 

Set of computer, 

Video /pictures, wall 

chart 

1. Identifying the 

possible health 

hazards of prolonged 

use of computing 

devices. 

 

2. Understanding the 

preventive measures 

to offset the health 

and safety risks. 
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• Television – affects vision 

• Computer – affects vision, back ache, wrist pain. 

• Mobile phone – radiation which can cause cancer, loud ring tones can 

damage hearing. 

• Radio – high volume damages hearing  

• Public address system – high volumes damages hearing. 

 

Brainstorm learners to provide preventive measures regarding the stated 

health and safety risks. 

 

 

Reflection (10 mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

Homework/Project Work/Community Engagement Suggestions 

• Identify any five ICT tools you know. 

• Explain the prolong health hazard associated with the tools identified above. 

Cross-Curriculum Links/Cross-Cutting Issues 

 

Potential Misconceptions/Student Learning Difficulties 

• Learners may not consider bad postures as health hazards 
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Strand : Introduction to computing   Class : B7 

Sub Strand: Health and Safety in using ICT tools Duration : 50mins 

Content Standard: B7.1.3.1. Demonstrate how to apply Health 

and Safety measures in using ICT Tools 

Date : 

Indicators: B7.1.3.1.2 Describe Safety measures in using ICT tools Day : 

Key words: typing, injuries, posture 

 

Activities For Learning & Assessment Equipment/Resources Progression  

Starter (5 mins) 

 

Recap with learners to review their understanding in the previous 

lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

 

Main (35 mins) 

 

Revise with learners on the possible health hazards associated with long 

term exposure to the use of ICT tools. 

 

Guide learners to discuss the safety precautions for the use of ICT 

tools. 

i.e. holding mouse, typing, looking at the computer screen, etc. and the 

risk of injuries to one’s neck, back, eyes, etc. 

 

Demonstrate to learners, the correct body posture for working with a 

personal computer and let learners practice correct posture. 

 
 

Guide learners to discuss the danger of spilling liquids on a computer 

device or on the electronic circuit.  

Set of computer, Video 

/pictures, wall chart 

1. Identifying the 

possible health 

hazards of 

prolonged use of 

computing 

devices. 

 

2. Understanding 

the preventive 

measures to offset 

the health and 

safety risks. 
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Let learners discuss tripping over power cables and touching the 

negative and positive terminals of electrical wires 

 

 

Reflection (10 mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

Homework/Project Work/Community Engagement Suggestions 

• Learners should complete a group-based project, listing any five (5) health and safety issues associated with the use 

of technology tools and suggest preventive measures to combat each. 

Cross-Curriculum Links/Cross-Cutting Issues 

 

Potential Misconceptions/Student Learning Difficulties 

• Learners may not consider bad postures as health hazards 
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WEEK 8 

Strand : Introduction to computing   Class : B7 

Sub Strand: Health and Safety in using ICT tools Duration : 50mins 

Content Standard: B7.1.3.1. Demonstrate how to apply Health 

and Safety measures in using ICT Tools 

Date : 

Indicators: B7.1.3.1.3 Demonstrate how to apply Health and 

Safety measures in Using ICT Tools 

Day : 

Key words: typing, injuries, posture 

 

Activities For Learning & Assessment Equipment/Reso

urces 

Progression  

Starter (5 mins) 

 

Recap with learners to review their understanding in the previous lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

 

 

Main (35 mins) 

 

Revise with learners on the possible health hazards associated with long 

term exposure to the use of ICT tools. 

 

Guide learners to discuss the safety precautions for the use of ICT tools. 

i.e. holding mouse, typing, looking at the computer screen, etc. and the 

risk of injuries to one’s neck, back, eyes, etc. 

 

Get learners to demonstrate how to apply Health and Safety measures in 

using ICT Tools. 

1. Phone  

- Do not answer or receive calls when charging a mobile phone. 

- Avoid long conversation 

- Use headsets or speaker out option 

- Keep mobile devices away from your body when sleeping 

- Turn Off cellular data and Wi-Fi when not in use, etc. 

 

2. Avoid plugging ICT tools in damaged sockets  

3. Do not overload socket.  

4. Ensure a good body posture when using ICT tools  

5. Take regular breaks when working with ICT devices . 

6. Position your body correctly when using the computer 

7. Television 

- keep lights on when watching television. 

- do not sit close to your television set. 

 

Learners in turns or groups demonstrate how to apply Health and Safety 

measures in using ICT Tools. 

 

Set of computer, 

Video /pictures, 

wall chart 

1. Identifying the 

possible health 

hazards of prolonged 

use of computing 

devices. 

 

2. Understanding the 

preventive measures 

to offset the health 

and safety risks. 
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Reflection (10 mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

Homework/Project Work/Community Engagement Suggestions 

• In groups of five (5), enumerate the possible health hazards of prolonged use of computing devices. 

• Suggest five (5) preventive measures to reduce health and safety risks associated with the use of computers 

Cross-Curriculum Links/Cross-Cutting Issues 

 

Potential Misconceptions/Student Learning Difficulties 

• Learners may not consider bad postures as health hazards 
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Strand : Introduction to computing   Class : B7 

Sub Strand: Health and Safety in using ICT tools Duration : 50mins 

Content Standard: B7.1.3.1. Demonstrate how to apply Health 

and Safety measures in using ICT Tools 

Date : 

Indicators: B7.1.3.1.4 Explore safety measures at workstations Day : 

Key words:7 

 

Activities For Learning & Assessment Equipment/Resourc

es 

Progression  

Starter (5 mins) 

 

Recap with learners to review their understanding in the previous 

lesson. 

 

Share performance indicators and introduce the lesson. 

 

 

 

Main (35 mins) 

Guide learners to identify measures that will help to eliminate 

workstation hazards and where they cannot be eliminated,  

 

In groups, learners discuss how to minimize the risk.  

(e.g. evaluating display screen, adjusting the chair for comfort, avoiding 

potential slips and falls, re- positioning of devices, etc.) 

 

 

Reflection (10 mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

Set of computer, 

Video /pictures, wall 

chart 

1. Identifying the 

possible health 

hazards of 

prolonged use of 

computing devices. 

 

2. Understanding 

the preventive 

measures to offset 

the health and 

safety risks. 
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WEEK 9 

Strand : Productivity Software   Week Ending:  

Sub Strand: Introduction to Word Processing Duration :50mins 

Content Standard: B7.2.1.1 Demonstrate how to use Microsoft 

Word 
Class : B7 

Indicators: B7.2.1.1.2. Demonstrate how to insert, select, delete and 

move text 
Day : 

Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, evaluate 

and effectively use it to solve a problem. 

 

Activities For Learning & Assessment Equipment/Resou

rces 

Learners 

Resource Page 

Ref. 

Progression  

Starter (5 mins) 

 

Recap with learners to review their understanding in the 

previous lesson. 

 

Introduce the lesson by sharing the performance 

indicators. 

 

 

 

Main (35 mins) 

Brainstorm learners to come out with the meaning of 

editing. 
Editing is the process of correcting mistake changes to the content 

of a document. 

 

Show projected examples of MS-Word interface with 

the aid of a computer, projector or pictures.  

 

Guide learners to discuss the ways of editing a 

document. 

Example: inserting text, moving text, deleting text, undo, 

redo and spelling & grammar check. 

Demonstrate to learners, how to insert, move and 

delete text in a word document. 

Example: to insert text 
1. Move the insertion point to where you want to insert the text. 

2. Click to place the insertion point 

3. Start typing the text 

 

Learners practice how to use the undo, redo and 

spelling & grammar check tools for editing. 

 

Have learners to explore more tools for editing in MS 

Word. 

 

Set of computer, 

Video /pictures  

 

Computing 

Curriculum Pg. 8-

9 

Learning how 

to use insert 

text, move 

text, delete 

text, undo, 

redo and use 

the spelling & 

grammar 

check 
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Explore the use of the overtype or insert option by 

right-clicking the status bar. 

 

 

Reflection (10 mins) 

We have learnt how to use spelling and grammar check 

as well as setting language preferences. 

  

Engage learners in a think-pair-share activity to practice 

how to spell and grammar check text in a passage.  

Homework/Project Work/Community Engagement Suggestions 

• What is editing? 

• State three ways of editing a word document. 

• Describe how to insert a text in a word document. 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory. 
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Strand : Productivity Software   Week Ending:  

Sub Strand: Introduction to Word Processing Duration :50mins 

Content Standard: B7.2.1.1 Demonstrate how to use Microsoft 

Word 
Class : B7 

Indicators: B7.2.1.1.3-4. Demonstrate how to find and replace 

content and undo edited changes and demonstrate how to spell 

check, carry out content translation, language setting 

Day : 

Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, 

evaluate and effectively use it to solve a problem. 

 

Activities For Learning & Assessment Equipment/Resou

rces 

Learners 

Resource Page 

Ref. 

Progression  

Starter (5 mins) 

 

Recap with learners to review their understanding in 

the previous lesson. 

 

Introduce the lesson by sharing the performance 

indicators. 

 

 

 

Main (35 mins) 

 

Guide learners to make use of the Find and Replace 

tool in MS-Word under the Home tab.  

 
 

 
 

Have learners to explore the use of the Editing group 

under the Home tab. 

 

Guide learners to demonstrate the use of the Proofing 

and Language group under the Review tab.  

 

Set of computer, 

Video /pictures  

 

Computing 

Curriculum Pg. 8-

9 

Learning how 

to use Find 

and Replace 

tool in MS-

Word, 

Proofing and 

Language 

group, 

Spelling & 

Grammar, 

Thesaurus 
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Show how to use the Language, Spelling & Grammar, 

Thesaurus and other tools in MS-Word under the 

Home tab.  

 

 

Reflection (10 mins) 

We have learnt how to use replace tool in MS-Word, 

Proofing and Language group, Spelling & Grammar, 

Thesaurus. 

  

Engage learners in a think-pair-share activity to practice 

how to use replace tool in MS-Word and spell and 

grammar check text in a passage. 

Homework/Project Work/Community Engagement Suggestions 

• What is editing? 

• State three ways of editing a word document. 

• Describe how to insert a text in a word document. 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory. 
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WEEK 10 

Strand : Productivity Software   Week Ending:  

Sub Strand: Introduction to Word Processing Duration :50mins 

Content Standard: B7.2.1.1 Demonstrate how to use 

Microsoft Word 
Class : B7 

Indicators: B7.2.1.1.5 Demonstrate how to use text-decoration, 

change text case, text size and color 
Day : 

Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, 

evaluate and effectively use it to solve a problem. 

 

Activities For Learning & Assessment Resources Learners 

Resource 

Page Ref. 

Progressio

n  

Starter (5 mins) 

 

Recap with learners to review their understanding in the 

previous lesson. 

 

Introduce the lesson by sharing the performance indicators. 

 

 

 

Main (35 mins) 

 

Guide learners to explore the use of the Font group under 

the Home tab. 

 

Quiz learners to mention some of the tools under the Font 

group. 

Example:  

Font style and Font size 

Bold, Italics and Underline 

Strikethrough 

Superscript and Subscript  

Increase and decrease font size 

 
 

 

Engage learners to demonstrate the use Bold, Italics, 

Underline 

Set of 

computer, 

Video 

/pictures  

 

Computing 

Curriculum Pg. 

8-9 

Learning 

how to use 

text-

decoration, 

change text 

case, text 

size and 

color in MS 

Word 
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Strikethrough, Superscript and Subscript in MS-Word. 

Example: 

 

The boy is going to school with his 

friends. 
 

 

4x4x4x4=44 

 

Two molecules of oxygen = O2 
 

Demonstrate the use of sentence case, font size, color and 

font decoration features in MS-Word 

Example:  

 

Chantal is an intelligent student. 

 

Changing the font style of a Text 

1. Highlight the text you want to change its font type. 

2. Click the font type list arrow and  

3. Select the font style of your choice from the list. 

Project examples of MS-Word interface to learners with 

the aid of a projector or pictures. 

 

 

 

Reflection (10 mins) 

We have learnt how to use replace tool in MS-Word, 

Proofing and Language group, Spelling & Grammar, 

Thesaurus. 

  

Engage learners in a think-pair-share activity to practice 

how to use replace tool in MS-Word and spell and 

grammar check text in a passage. 

Homework/Project Work/Community Engagement Suggestions 

1. Identify any five Editing tools you know. 

2. State the use of the following  

a. text-decoration,  

b. change text case,  

c. text size 

d. text color 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory. 

 

 

Bold  Strikethrough  Underline  Italics  

Superscript  

Subscript  
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Strand : Productivity Software   Week Ending:  

Sub Strand: Introduction to Word Processing Duration :50mins 

Content Standard: B7.2.1.1 Demonstrate how to use Microsoft 

Word 
Class : B7 

Indicators: B7.2.1.1.6 Demonstrate how to align text, indent 

paragraphs, bullet, line space and shade 
Day : 

Core competences: DL5.1: Ability to ascertain when information is needed and be able to identify, locate, 

evaluate and effectively use it to solve a problem. 

 

Activities For Learning & Assessment Resources Learners 
Resource Page 
Ref. 

Progression  

Starter (5 mins) 

 

Recap with learners to review their understanding in the 

previous lesson. 

 

Introduce the lesson by sharing the performance indicators. 

 

 

 

Main (35 mins) 

 

Guide learners to explore the use of the Paragraph group, 

using the align left, center, align right and justified in MS-

Word under the Home tab.  

 
 

Guide learners to explore the use of Bullets, Decrease and 

Increase Indentation under the Home tab.  

 

 

Guide learners to identify the use of the Border Button and 

set line spacing using the dialogue Box Launcher button 

under the Home tab.  

Set of 

computer, 

Video 

/pictures  

 

Computing 
Curriculum Pg. 8-
9 

Learning how 
to how to 
align text, 
indent 
paragraphs, 
bullet, line 
space and 
shade in MS 
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Reflection (10 mins) 

We have learnt how to use replace tool in MS-Word, 

Proofing and Language group, Spelling & Grammar, 

Thesaurus. 

  

Engage learners in a think-pair-share activity to practice how 

to use replace tool in MS-Word and spell and grammar check 

text in a passage. 

Homework/Project Work/Community Engagement Suggestions 

1. Identify any three Editing tools you know. 

2. State the use of the following  

a. align text  

b. indent  

c. paragraphs,  

d. bullet,  

e. line space and shade 

Cross-Curriculum Links/Cross-Cutting Issues 

None  

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory. 

 

 

 

 

Border 

button 

Line and Spacing 
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Strand : Productivity Software   Class : B7 

Sub Strand: Introduction to Presentation Duration : 100mins 

Content Standard: B7.2.2.1 Demonstrate how to use Microsoft 

PowerPoint (Editing): Introduction to PowerPoint. 

Date : 

Indicators: B7.2.2.1.1. Explain the importance of presentation 

software 

Day : 

Key words: multimedia, presentation, Corel, Adobe 

 

Activities For Learning & Assessment Equipment/Reso

urces 

Progression  

Starter (5 mins) 

 

Using questions and answers, review learners understanding in the previous 

lesson. 

 

 

 

Main (35 mins) 

Brainstorm learners to discuss the meaning of presentation software.  

Presentation software is a program used to create slide shows or multimedia presentations. 

 

Guide learners to explain the meaning of multimedia. 
Multimedia means presenting data in more than one medium, such as combining text, 

graphics, animation, video and sound. 

 

Have learners to discuss the benefits of using presentation software.  

 

Brainstorm to elicit the names of some common presentation software 

packages (e.g. MS-PowerPoint, Corel Presentation, Adobe persuasion, 

Google Slides, Keynotes etc.) 

 

 

 

Reflection (10 mins) 

Use peer discussion and effective questioning to find out from learners what 

they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

Computer with 

Microsoft 

PowerPoint, 

picture chart. 

Describing the 

importance of 

presentation 

software 

Homework/Project Work/Community Engagement Suggestions 

• What is a presentation software? 

• What is meant multimedia? 

• Mention three benefits of using presentation software. 

• State three examples of presentation software. 

Cross-Curriculum Links/Cross-Cutting Issues 

 

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 
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Strand : Productivity Software   Class : B7 

Sub Strand: Introduction to Presentation Duration : 100mins 

Content Standard: B7.2.2.1 Demonstrate how to use Microsoft 

PowerPoint (Editing): Introduction to PowerPoint. 

Date : 

Indicators: B7.2.2.1.2. Explore features of MS-PowerPoint 

interface 

Day : 

Key words: Review tabs, language, spelling & grammar, thesaurus 

 

Activities For Learning & Assessment Equipment/Resourc

es 

Progression  

Starter (5 mins) 

Recap with learners to find out what they already know about MS 

PowerPoint. 

Example: have learners to demonstrate how to use icons in the Text 

group in the Insert ribbon 

 

Share performance indicators and introduce the lesson. 

 

 

Main (35 mins) 

Show examples of MS-PowerPoint interface with the aid of a projector or 

pictures.  

 

In groups, learners observe and talk about the picture. Guide learners to 

identify some of the features of the power point interface. 

 

Demonstrate the functions of the features of the MS-PowerPoint. 

 

Call volunteer learners to give the correct process of the launching the 

MS-PowerPoint. 

 

Guide learners to explore MS-PowerPoint themes and templates.  

 

Learners to explore the use of the Proofing and Language group under 

the Review tab.  

 

 
 

Demonstrate the use of the Language, Spelling & Grammar, Thesaurus 

and other buttons in MS-PowerPoint under the Review tab. 

 

  

Computer with 

Microsoft PowerPoint, 

picture chart. 

Exploring the 

features of MS-

PowerPoint 

interface 
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Reflection (10 mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson. 

Homework/Project Work/Community Engagement Suggestions 

• Give the correct steps of how to launch the MS-PowerPoint. 

• Identify and state the function of any five features of the MS-PowerPoint. 

Cross-Curriculum Links/Cross-Cutting Issues 

 

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory 
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WEEK 11 

Strand : Productivity Software   Class :B7 

Sub Strand: Introduction to Presentation Duration : 

Content Standard: B7.2.2.1 Demonstrate how to use Microsoft 

PowerPoint (Editing): Introduction to PowerPoint. 

Date : 

Indicators: B7.2.2.1.3. Demonstrate how to use Special 

Characters. Design a 7-slide presentation in MS-PowerPoint using 

the tools under the Insert ribbon 

Day : 

Key words: Microsoft PowerPoint, review tabs, language, Spelling & Grammar, thesaurus 

 

Activities For Learning & Assessment Equipment/Resources Progression  

Starter (5 mins) 

 

Learners give the steps of launching the MS PowerPoint and talk 

about its purpose and benefits.  

 

Learners explore the use of the Proofing and Language sections 

under the Review tab.  

 

Learners practice the use of the Language, Spelling & Grammar, 

Thesaurus and other buttons 

 

 

Main (35 mins) 

 

Explore the use of special characters section under the Insert tab 

under the symbol group  

 

Present a prepared project or exercise using the editing group of 

the ribbons studied.  

Use projected examples of a PowerPoint interface with the aid of 

a projector or pictures  

 

Use projected examples of a PowerPoint interface with the aid of 

a projector or pictures 

 

Reflection (10 mins) 

We have learnt how to use Special Characters to design a 7-slide 

presentation in MS-PowerPoint 

 

Engage learners in a think-pair-share activity on how to use 

templates and themes. 

 

Take feedback from learners and summarize the lesson.  

Computer with Microsoft 

PowerPoint, mouse or 

touchscreen input device, 

projector 

 

Read on how to 

use special 

characters under 

the Insert tab 

within the Symbol 

group 

Homework/Project Work/Community Engagement Suggestions 

Design a 7-slide presentation in MS-PowerPoint using the tools under the Insert ribbon 

Cross-Curriculum Links/Cross-Cutting Issues 

 

Potential Misconceptions/Student Learning Difficulties 
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Strand : Productivity Software   Class : 

Sub Strand: Introduction to Presentation Duration : 

Content Standard: B7.2.2.2 Demonstrate how to use Microsoft 

PowerPoint (Formatting). 

Date : 

Indicators: B7.2.2.2.1. Demonstrate how to change text case, text 

size, text color and decorate text. 

Day : 

Key words: Microsoft PowerPoint, review tabs, language, Spelling & Grammar, thesaurus 

 

Activities For Learning & Assessment Equipment/Resources Progression  

Starter (5 mins) 

 

Learners give the steps of launching the MS PowerPoint and talk 

about its purpose and benefits.  

 

Learners explore the use of the Proofing and Language sections 

under the Review tab.  

 

Learners practice the use of the Language, Spelling & Grammar, 

Thesaurus and other buttons 

 

 

Main (35 mins) 

 

Explore the use of the Font group under the Home ribbon.  

 

 Make use of the sentence case, font size, colour and font 

decoration features in MS-PowerPoint  

 

 Project examples of PowerPoint interface to learners with the 

aid of a projector or pictures.  

 

 

 

Reflection (10 mins) 

We have learnt how to change text case, text size, text color 

and decorate text. 

 

Engage learners in a think-pair-share activity on how to use 

templates and themes. 

 

Take feedback from learners and summarize the lesson.  

Computer with Microsoft 

PowerPoint, mouse or 

touchscreen input device, 

projector 

 

Read on how to use 

special characters 

under the Insert tab 

within the Symbol 

group 

Homework/Project Work/Community Engagement Suggestions 

ask learners to develop a 5-page slide and apply the special characters under the Insert tab within the Symbol group. 

Cross-Curriculum Links/Cross-Cutting Issues 

 

Potential Misconceptions/Student Learning Difficulties 

The facilitator/teacher can arrange to use a nearby Senior High School (SHS) ICT laboratory. 
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WEEK 12 

Strand : Strands treated for the term Class : B7 

Sub Strand: Sub strands for the term Duration : 50 mins 

Content Standard: Demonstrate knowledge and understanding in the topics treated so 

far. 
Date : 

Indicators: Recall and summarize all what they have learnt within the term. Day : 

Key words: 

 

Activities For Learning & Assessment Equipment/Resourc

es 

Progression  

Starter (5 mins) 

 

Revise previous lesson with learners using questions and answers. 

 

 

 

Main (35 mins) 

 

Revise with learners to discuss features of fourth generation computers.  
The computers of fourth generation used very large scale integrated (VLSI) circuits. This 

made computers more powerful, compact, reliable and affordable. As a result, it gave rise 

to personal computers (PC) revolution. E.g. desktop computers, laptop, notebook, etc. 

 

Guide learners to Identify and explore the physical features of a microchip  

 

Revise with learners to demonstrate the use of input devices in a computer 

laboratory/classroom.  

  

Have learners to distinguish manual (e.g. keyboard, etc.) and automatic (e.g. 

barcode reader etc.) input devices.  

 

Using pictures, brainstorm learners to come out with the use of the output 

devices. 

 

Guide learners to demonstrate the use of output devices in a computer 

laboratory or classroom.  

 

Let learners explore the advantages and disadvantages of output devices. 

 

Revise with learners to Identify magnetic storage devices, portable hard 

drives/Optical Discs and Drives or pictures of these items to class 

 

Guide learners to discuss in groups and present to the whole class 

examples of energy-efficient devices and techniques. 

 

Revise with learners on the negative impact of computers and computer 

use on the environment. 

Example: Negative effects – resource depletion ,pollution, privacy and 

security etc 

 

Set of computer, 

Video /pictures, wall 

chart 

Learning how 

to identify and 

use output 

devices 

 

Proposing 

environmentally 

responsible 

practices that 

can be used to 

reduce the 

negative impact 

of computers 

and computer 

use on the 

environment 
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Reflection (10 mins) 

Use peer discussion and effective questioning to find out from learners 

what they have learnt during the lesson.  

 

Take feedback from learners and summarize the lesson.  

 

Ask learners how the lesson will benefit them in their daily lives. 

Homework/Project Work/Community Engagement Suggestions 

• State any two features of fourth generation computers 

• What is the main function of the microchip in computers 

• Identify any two negative effect of computers on the environment. 

• State two ways of reducing the negative effects identified.  

• What is an input device? 

• Mention the least input devices of a computer 

• Draw any 2 input device. 

• What is an output device? 

• Mention any five output device you know. 

• State the functions of the output devices stated above 

Cross-Curriculum Links/Cross-Cutting Issues 

 

Potential Misconceptions/Student Learning Difficulties 

The facilitator can arrange to use the nearby school’s computer lab 
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Strand : Strands treated for the term Class : B7 

Sub Strand: Sub strands for the term Duration : 50 mins 

Content Standard: Demonstrate knowledge and understanding in the topics treated so far. Date : 

Indicators: Preparation towards vacation Day : 

Key words: 

 

Activities For Learning & Assessment Equipment/Resourc

es 

Progression  

Starter (5 mins) 

 

Ask learners to bring and display all the materials needed for the 

assessment. 

 

Educate them on the consequences of examination mal practice. 

 

 

Main (35 mins) 

 

Engage learners to arrange themselves properly to sit for the assessment 

test. 

 

Mark learners answer sheets or exercise books. 

 

Fill in learner’s SBA books and report cards. 

 

Distribute learners answer sheets or exercise books for feedback. 
 

Exercise books, pen, 

pencils, erasers, 

Answer sheets. 

Answering end 

of term 

examination 

assessment 

questions. 

 

 

 

 

 

 


